Digital literacy training

NVivo11

Introduction: Project Set-Up & Coding
2018
Table of Contents

Introduction to NVivo: Project Set-Up & Coding ................................................. 1
Recommended Steps in Setting up an NVivo Project .......................................... 1
The NVivo Workspace ......................................................................................... 2

CLASSIFICATIONS AREA  FIRST STEPS: Define Cases, Create Classifications,
Attributes and Relationships ............................................................................. 2
  What are Attributes & Values? ........................................................................ 3
  Creating Classifications and Associated Attributes ....................................... 4
  Applying Classifications & Associated Attributes ......................................... 4

SOURCE AREA Importing Data Files .................................................................. 4
  Importing ......................................................................................................... 5
  Adding External Data Sources ........................................................................ 6
  [OPTIONAL] Importing Social Media and Web Pages NCapture .................... 6
  Web Pages ...................................................................................................... 6
  Facebook/Twitter ............................................................................................ 6
  YouTube ......................................................................................................... 7

NODES AREA Create Nodes ............................................................................... 7
  What is a Node? ............................................................................................... 7
  Research Nodes vs Contextual Nodes ............................................................. 8
  What is a Case Node? ...................................................................................... 8
  Opening a Node to View All the References Coded to It ............................... 8
  Reference Tab Information ........................................................................... 8
  Creating a New Case Node ............................................................................ 8
  Creating a New Node .................................................................................... 9
  Creating Child Nodes ................................................................................... 9
  Aggregation .................................................................................................... 9
  Creating Folders ............................................................................................ 9
  Merging Nodes .............................................................................................. 10
  [OPTIONAL] Creating a Relationship between Cases .................................... 10
  Using Mind Maps to Create Nodes ................................................................. 10
  Autocoding Nodes & Case Nodes .................................................................. 10
  Auto Coding Datasets .................................................................................. 11
  Auto Coding Using Paragraph Styles ............................................................ 11

Coding Your Data ............................................................................................. 11
  What is Coding Context? ............................................................................. 11
  What is Coding-On? ...................................................................................... 12
  How to Code a Selection of a Document to a Node ....................................... 12
  How to See What Has Been Coded within a Source ...................................... 13
  [OPTIONAL] Coding Audio and Video data .................................................. 13
  [OPTIONAL] Coding Pictures ..................................................................... 13
  Uncoding Within Nodes and Sources ............................................................ 13

Collections Area ............................................................................................... 14
  Creating Annotations .................................................................................... 14
  Creating Memos ............................................................................................ 14
  Creating Links ............................................................................................... 15
  Creating a New Set ....................................................................................... 15

Brief Overview of Other Areas in NVivo ........................................................... 15
  Queries Area .................................................................................................. 15
  Reports Area .................................................................................................. 15
  Models Area .................................................................................................. 15
  Folders Area ................................................................................................. 15
# NVivo Introduction

## [OPTIONAL] Creating Transcripts

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transcribe Mode</td>
<td>16</td>
</tr>
<tr>
<td>Normal Mode</td>
<td>16</td>
</tr>
<tr>
<td>Dividing Media</td>
<td>16</td>
</tr>
<tr>
<td>Custom Fields in Transcripts</td>
<td>16</td>
</tr>
</tbody>
</table>

Digital literacy training
Introduction to NVivo: Project Set-Up & Coding

NVivo can do a phenomenal number of things to help you analyse your qualitative data. It can also help you analyse a large variety of source material: text, audio, video and pictures. This course will show you how to use the most commonly needed NVivo tools in data analysis for all of these formats. For further information about NVivo’s full capabilities, please refer to the NVivo 11 help website: http://help-nv11.qsrinternational.com/

This session will cover:

- Recommended steps in setting up a Research Project in NVivo.
- How to set-up broad source material descriptions, relationships and demographics in Classifications.
- How to create, view and organise coding schemes in the Nodes area.
- How to Import data files.
- How to create Cases and apply Attribute values.
- How to Auto Code to create contextual Nodes.
- How to manually code and uncode text, sound, picture, and video.

When you open NVivo it will ask you to create a user ID: enter your Initials (must be unique to the Project) and (optional) your name. This is important when you’re collaborating with others.

Open the sample project to explore how NVivo can be used to analyse your data. When you open NVivo, at the top of the Welcome Screen there is an option to open a new Sample Project. Select the sample project which is a two-year study (2008-2009) documenting community perceptions of development and land-use change on coastal communities in the Down East area of Carteret County, North Carolina, USA.

Click on the Blank Project icon at the top of the screen to create a new NVivo project for your research. Give it a Title and optional Description, choose where to save the file by clicking on the Browse button. When you are done, click OK.

NOTE: Saved Projects can be opened on any computer with NVivo and can be altered by any collaborator (a record of who changes what is kept according to User ID).

Recommended Steps in Setting up an NVivo Project

It may seem counterintuitive, but setting up an NVivo Project is more efficient if you create your research project variables BEFORE importing any data. The recommended steps are as follows:

1. Identify what your Cases will be (your units of measurement, such as people/ reports/ organisations). These will be stored in the Case Nodes folder in the Nodes Area, and determine your Case Classifications in the Classifications Area.
2. Set up your “Independent Variables” (e.g., groups for later comparison) in the Classifications Area.
3. Import your Data in Internal Sources and create Case Nodes. Apply Classifications and assign Attribute values to your Sources and Case Nodes.
4. Set up your “Research Variables” (the themes you want to code and count) in the Nodes Area.
5. Create Contextual Nodes if needed (e.g., a Node for Attitudes, each survey question).
6. (Optional) Prepare your project for collaboration, in Sets and/or Memos.
The NVivo Workspace

The Navigation View is where you can easily navigate the different Areas of your NVivo Project. When you click on an Area in the Navigation Pane, a list of folders in that Area appears at the top of the pane. When you click on a folder, the list of items it contains is presented in a window to the left called the List View. When you open an item in the List View, its content appears in the Detail View. The Ribbon contains commands in tabs. The Find Bar is a shortcut to search for items your Project. The Quick Coding Toolbar has shortcuts for coding your data. The Status Bar provides information for the Project Item you have open.

Note: Throughout using NVivo you’ll find that your best-friend is Right-Clicking: it gives you a context-dependent short-cut menu with all the appropriate options for the space/object clicked. This way you don’t have to remember which menu tab has the function you need.

Note: The Navigation View can be hidden to make more room on the screen by clicking the arrow symbol at the top right-hand side of the View.

CLASSIFICATIONS AREA
FIRST STEPS: Define Cases, Create Classifications, Attributes and Relationships

This area includes the higher-order information about your Project Items and Cases.

HANDY HINT: By defining the classifications, their attributes and values FIRST, you are able to classify your data DURING the import process. This saves a lot of time, particularly because it has the added benefit of ensuring you plan your project thoroughly before you start coding.

What are Cases?

Technically, Cases are the units of measurement for your research. They can be individual people/reports/articles (or other special instances you wish to be able to measure) in your project design. For example, if you want to be able to say: “X number of People said Y”, then People will be your Cases. You can have multiple types of Cases if you have more than one unit of measurement (e.g., a Case type for Person and a Case type for Organisation).
In order to help NVivo identify individual Cases for analysis, you need to create a **Case Node** for each one. Case Nodes also allow you to see all the content relating to each Case (e.g., everything person A said) when you open them. These are filed as special types of Nodes in the **Cases** folder in the **Nodes** Area.

**What are Sources?**

**Sources** are the *types of data sources* you use in your research. For example you may have interviews, surveys or articles (or a combination of sources). You need to set up Source classifications if you have multiple types and need to separate them during analysis, and if you are working with reference material and need to record bibliographical information etc..

**What are Classifications?**

There are two types of classifications you need to apply to the higher-order information in your project:

- **Source Classifications** – the type(s) of **Source** material in your project (e.g., Interview, Article or Web Page). You might only have one type of source.
- **Case Classifications** – the type(s) of **Cases** in your project (e.g., Person, Organisation, Location). You might only have one type of case.

**What are Attributes & Values?**

Each **Classification** has a set of *unique, mutually exclusive Attributes*: the relevant variables that relate to the **Classification**. For example, the predefined **Case Classification Person** has **Age, Sex and Occupation** attributes. Within each attribute is a defined set of possible **values** (e.g., within **Sex** the options are Male or Female). These are also mutually exclusive (e.g., you cannot select more than one attribute value per case). **Case Classifications** need to include the breakdown variables (*independent variables*) you will use in your analysis: E.g. if you believe that there will be differences due to the states/territories in which the **Cases** live, then states/territory should be in attribute of the classification for **Person**.

<table>
<thead>
<tr>
<th>Classification</th>
<th>Attribute</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person</td>
<td>Age</td>
<td>20-25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>26-30</td>
</tr>
<tr>
<td></td>
<td></td>
<td>31-35</td>
</tr>
<tr>
<td></td>
<td>Sex</td>
<td>Female</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Male</td>
</tr>
</tbody>
</table>

**Source Classifications** will have **Attributes** related to the type of **Source** material (e.g., bibliographic information about your reference material. **Note:** can import this information from EndNote).
Creating Classifications and Associated Attributes

You need to set up classifications for Sources and Cases separately in NVivo11 and they will be added to the appropriate folder in the Classifications Area, but the process is identical.

Example: Create a Case Classification and Attributes for Philosopher.

In the Create tab area, click on Case Classifications. Create a classification called "Philosopher" and give it an (optional) description. This will create the classification and then you can add its Attributes. Right-click on the new Philosopher classification and select New Attribute. Give it a name and (optional) description, such as Nationality on the General tab. Select its value Type (here text). On the Values tab, you can set up the different nationalities for the attribute: click Add and enter a new value in the row that appears (e.g., French) assign a description and/or colour if you wish), then click Add again to add the others. Then click OK when you’ve finished (do not click ADD again as it will not let you continue until you add another). You can add other attributes to the Philosopher classification this way too (e.g., “School of Thought”, with the values “Existentialism”, “Rationalism”).

HANDY HINT: You can delete and reorder Attributes by clicking on the arrow on the left-hand side of the row you want to remove or delete to highlight it, and then click on the appropriate button below (remove, move up or move down).

Applying Classifications & Associated Attributes

When you have your Sources and Cases in the Project you need to associate them with their relevant Classifications and assign Attribute values. If you haven’t already assigned a Classification to your Cases during import, do this by selecting one or more Sources or Cases, right-click on the selection and go to the Classification section of the menu and choose the appropriate one (e.g., Person or Journal Article). Once the Sources/Cases have been classified, they will then be available for classification in the Classification Sheet which is found in the Classifications Area of the Navigation View.

Find the relevant Classification (e.g., Person) and double-click on it to open the Classification Sheet (or right-click on the Classification and select Open). This will produce a new tab with a spreadsheet. The columns represent each Attribute and rows represent each Source/Case. Select the appropriate Attribute values in each column for every Source/Case in each row (either using drop-down lists or typing them in).

What are Relationship Classifications?

NVivo allows you to keep track of relationships (or connections) which exist between Nodes and/or project items (e.g., one person may be a sibling of another). Relationships are recorded and stored in the Relationships folder of the Nodes Area, but these have to be set-up in Classifications under Relationship Types FIRST in order to apply them as relationships.

Example: Create a Sibling relationship type.

On the Create tab, in the Classifications group, click Relationship Type. Enter a Name (e.g., Sibling) and (optional) Description and in the Direction list select a direction (e.g., Associative). Then click OK.

SOURCE AREA
Importing Data Files

This is where you’ll store all of your project resources. You can not only store your qualitative data for analysis (e.g., interviews, surveys results), but also your research material (e.g., journal articles). There are 4 source folders:
• **Internals**: all the data and notes which you want NVivo to analyse should be stored here within the NVivo Project itself.

• **Externals**: links to data and notes which you don’t need NVivo to analyse can be stored here outside the NVivo Project (e.g., things that you cannot import into NVivo, PowerPoint slides, or really big files like audio and video that are better to store outside to save computing power).

• **Memos**: all the memos you create which are either linked or unlinked to project items (can also find these in Collections).

**HANDY HINT**: NVivo analyses data more easily and quicker with less data to search through in a Project. You can save the material not needed for analysis in the Externals folder OR create a separate NVivo Project for your literature review.

You can see the sources already imported into the Project by clicking on the appropriate source folder and the list of files will be displayed to the right in the List View Window Pane. To see the actual source, double-click on the file and it will open up in a new Window Pane called the Detail View on the right-hand side of the screen.

New folders can be created within the Source Area by right-clicking on the appropriate source folder, selecting New Folder and giving it a name (e.g., “Test Folder”) and (optional) description. You can also create new Internal Documents by right-clicking in the List View and selecting New Internal and new Document (new audio and video files will still need to be imported). Give it a name and (optional) description.

**Importing**

Apart from being able to create your own text documents within NVivo, you can also import data in the following formats in NVivo Pro/Plus (only text in the Starter version):

- **Audio**: *.mp3, *.mp4, *.m4a, *.wma, and *.wav.
- **Web Pages**: as PDF files using NCapture.
- **Social Media**: Facebook, YouTube, LinkedIn and Twitter using NCapture.
- **Other**: survey responses from SurveyMonkey, Evernote notes, Outlook emails (as *.pdf) and supported attachments, and EndNote/Mendeley/RefWorks/Zotero data.

**HANDY HINT**: You can select multiple files and import them into NVivo at the same time (although datasets must be imported one-by-one). However, you will need to define the source properties after import, and NVivo will use the file name as the name of the Source/Case by default.

**Creating Case Nodes When Importing Sources**

When each source file represents one Case in your project, you can automatically create a Case Node for it and NVivo will code all of the text etc. in the file as belonging to that Case.

Example: Importing a *.doc file belonging to one Case

In Navigation View, click the name of the sources folder that you want to import the data file into (e.g., Internals). On the Data tab, click the icon for the type of data you want to import (e.g., Document). Select the file you want to import, then OK. If this file belongs to one Case (e.g., University), then click on the More button to Classify the document appropriately.
NVivo Introduction

Tick the **Code sources at Cases located under** and ensure **Cases** is selected, and click the **Select** button to choose the appropriate Classification. Once you’ve done this, click **OK** and **OK** again.

A new window opens and you have the option of changing the **Name** and (optional) adding a **Description** of the new document source. Then click the **Attribute Values** tab and assign the appropriate **Source Classifications** (if necessary) and **Values**, then click **OK**.

**HANDY HINT:** Audio, Video, Dataset and PDF files need to be edited before import. It’s also good idea to spellcheck documents before importing also.

---

Adding External Data Sources

When you have large files, such as audio and video, it’s usually a good idea to add them to the project as an **External Data Source** rather than import them as part of the project. It reduces the sizes of the project file and saves on computing power when running analyses.

**Please note** that you will not be able to use NVivo to analyse the content of external sources, only the notes or comments you linked to them.

In the **Externals** folder, right-click on the space in the **Detail View** and select **New External**. Enter a name and optional description on the **General** tab. On the **External** tab choose the **External Type** (e.g., File Link) then click the **Browse** button to file the location of the file. The file MUST always go where the NVivo Project goes, or else the link will break. You can give it a location description and select the **Contents** Type from the drop-down menu and **Unit** Type from the next menu.

On the **Attributes Values** tab select a **Classification Type** if appropriate (e.g. **Reference**) and assign coding **Attributes**. Then click **OK**. The external will open in edit mode and you can enter content related to the external to be coded later on. If you want to open the external file, right-click on the external source and select **Open External File**.

**[OPTIONAL] Importing Social Media and Web Pages**

**NCapture**

There is an add-on for **Internet Explorer** and **Google Chrome** web browsers called **NCapture** for NVivo. It automatically converts web pages to pdf and social media conversations into spreadsheet tables ready for analysis.

**Web Pages**

**Example: Capturing and importing a Wikipedia Page in Google Chrome.**

To save pages as pdf and import them into NVivo: while you are on the web page in **Chrome** or **Internet Explorer** (e.g., the Wikipedia Page for your favourite **author**) select **NCapture** and click **Web Page as PDF** as the source type. Change the **name** (e.g., **Agatha Christie**) and (optional) enter a **description** and linked memo if you wish. You can also ask it to code the source at import by adding terms to the **Code at Nodes** box. Then click **Capture**.

In NVivo, go to the folder in which you wish to import the data. On the **External Data** menu tab, select **From Other Sources** and click **From NCapture**. Select the appropriate option (**All captures not previously imported, All or Selected**). Then click **Import**.

**Facebook/Twitter**

When you are on the FB page, you can save the **News Feed** page or a **User Wall** as a PDF file only with **NCapture**. Follow the same directions as for web pages above. If you are displaying **Wall Posts** for a **Page** or **Group**, or a **Twitter Feed** (e.g., [www.Twitter.com/ANUmedia](http://www.Twitter.com/ANUmedia)) you can use **NCapture** to save the content as a **Dataset**.
**Note:** You can merge social media datasets into one table for ease of analysis (takes note of where the files came from as Nodes). Tick the **Merge matching social media datasets (including previously imported)** check box, and any matching Facebook datasets are merged together (if they contain wall posts for the same User, Page, or Group).

**YouTube**

When you use NCapture to capture video in YouTube, it creates a video source file which is essentially a shortcut link to the video in YouTube (an **External Source**) which is played within NVivo. If the video is removed from YouTube you will not be able to play it. If you also capture the YouTube comments this creates a dataset within NVivo as an Internal source which can be analysed.

**NODES AREA**

**Create Nodes**

This Area contains all the information relating to the coding you have conducted to summarise your qualitative data. It has folders for:

- **Nodes**: Nodes containing everything you have coded.
- **Case Nodes**: Nodes containing all the information relevant to your units of measurement.
- **Relationships**: A record of the Relationships you note between project items (e.g., which People are Married, which Authors are Collaborators).
- **Node Matrices**: Cross tabulations you create during Matrix Coding Queries [*More on this next course*].

**What is a Node?**

**It might be easier to think of Nodes as being the same thing as Codes.** However, technically a **Node** is the term used for a **collection of all the references you have coded** as belonging to a specific research theme. For example, all the text/audio/video in the sample project which refers to infrastructure has been **coded to a Node** called “Infrastructure”. When you open the Node called “Infrastructure”, you will see a summary of all data that was coded in the **Detail View** on the right-hand side.

Nodes can be:

- **Free** - stand-alone topics/themes (e.g., *Balance*).
- **Tree** - hierarchical grouping of Nodes indicated by a +/- symbol to expand and collapse the tree. The higher-order Node is termed the “**parent**” and lower-order Nodes “**children**” (e.g., *Economy* is a parent Node and *Agriculture, Tourism* etc. are its children).

**HANDY HINT:** You can **set-up Nodes for the codes you intend to use before coding your data**; this does help to ensure coding doesn’t go beyond the scope of your project. They can always be changed, added to and reorganised as you go along. You can also use the **Mind Map** feature in NVivo to create your initial Node structure [*more on this Advanced course*].

**HANDY HINT:** Try to **restrict Tree Nodes** to the “child” level, and don’t go beyond to “grandchildren” or “great-grandchildren”. It makes analysis simpler and limits your Nodes to only the essential ones.

**HANDY HINT:** **NEVER duplicate nodes** – there is no need to, as segments of source material can be coded to multiple nodes.
Research Nodes vs Contextual Nodes

I recommend creating “Contextual” Nodes to make future analysis easier. Contextual Nodes are different to your standard “Research” Nodes in that they solely provide some context to the data being investigated (e.g., Responses to Question 1, Negative Attitude, Positive Attitude) rather than being important themes you are investigating (e.g., Water Quality, Air Quality). They are also different to the Classification characteristics of your cases, which are used to group your Cases/Sources for analysis (e.g., Male, Female, Age Group) rather than grouping the discrete sections of the qualitative data (e.g., Responses to Survey, Responses in Focus Group).

What is a Case Node?

As mentioned previously, NVivo uses Case Nodes to identify your Cases for later analysis (e.g., count how many People said X). A Case Node collects all the information related to one case in your data set.

Opening a Node to View All the References Coded to It

The List View in the Node Area provides information regarding the number of Sources that are coded at the Node (e.g., how many text and video files), as well as the number of References (sections of text). You can see the actual content of the Node by double-clicking on it (e.g., Infrastructure) or right-click on it and select Open Node. The content is displayed the Detail View. Here you will find tabs on the right-hand side for:

- **Summary** - the sources of the references coded.
- **Reference** - the actual text coded with coverage details and number of codes assigned.
- Other tabs with thumbnail links to the actual Text/Picture/Audio etc. files.

Reference Tab Information

- **Header**: Name of the Source coded, blue hyperlink to that Source, total number of references in that source coded at the Node and percentage of coverage (e.g., X% of the Source coded in this Node).
- **References**: Number of times the reference was coded at the Node (>1 if multiple users coded the same section of text).
- **Coverage**: Percentage of the source that the reference coding represents (e.g., for documents it represents the percentage of characters in the entire source).

**Note:** Number of references includes any double-coding of sections by multiple users

**Note:** If the Node is a parent and has Aggregation turned on, then coding at any child Nodes is included when calculating coverage. (More on this later).

Creating a New Case Node

How this is done best, depends on the type of data you have:

- If your Cases are in separate source files (e.g., separate Word or pdf files per Interviewee) then creating Case Nodes is easiest during Import.
- If your Cases are represented by separate rows in a spreadsheet file, then creating Case Nodes is easiest using the Autocoding function. [More on this later]
- If your Cases are in one Word document and their Case ID/Name is in a unique Heading Style, Autocoding is also the best method of creating Case Nodes.
Digital literacy training

- If you have information relating to one Case in multiple Source files, create a Case Node from scratch and code all relevant content to that Node.

To create a Case Node from scratch, go to the Nodes Area of the Navigation View, click on the Cases folder. Right-click on the Detail View and select New Node. Alternatively, on the Create tab, click Case and type in the name and (optional) description on the General tab. On the Attribute Values tab, you can relate the Node to a pre-specified Attribute (e.g., select the Person Classification and choose some of your demographics from the drop-down menu), then click OK.

You can also create a new Case Node for a Source file after it has been imported, by right-clicking on the Source, selecting Create As Cases. Choose where you want it to be filed (if you have a filing system), and Assign to Classification by choosing the appropriate option from the drop-down menu. Then you will find the new Case in the Classification Sheet.

**Note:** You can change classifications and attributes at any time by right-clicking on a Case Node, selecting Node Properties and changing selections appropriately.

### Creating a New Node

You can create nodes prior to coding if you wish; it isn't necessary but it does help to ensure coding doesn't go beyond the scope of your project. In the Nodes area of the Navigation View, click on the Nodes folder. Right-click on the Detail View in the Nodes folder, and select New Node. Type in the code's label (e.g., Schools of Thought) and add an (optional) description. You can also assign a specific colour to the node in the drop-down menu if you wish. Another method to create Nodes is to click on the Create tab, then click Node. You can also use the Mind Map function to create multiple hierarchical nodes. [More on this later].

**HANDY HINT:** It's good practice to define what a code means and any "rules" for applying the it to the data. This can be added to the description of the Node in NVivo and will assist in ensuring reliability and validity of your coding scheme. If multiple people are coding the data (recommended for reliability checks), then there is a clear record of what the code means and how it should be applied in practice. It should also be noted in reports, so that readers can assess the validity of the code.

### Creating Child Nodes

Right-click on the Node you want to turn into a “parent” (e.g., the Schools of Thought) and select New Node. Give the new node a name (e.g., Rationalism), give it a (optional) description, then click OK. You can also turn a Free Node into a Child Node by cutting and pasting it into the intended Parent Node and selecting Merge into New Child Node, or by clicking and dragging the Free Node into the Parent Node.

### Aggregation

It's a good idea to consider if you want to aggregate the coding in your child Nodes with that of the parent Node for analysis. Right-click on the parent Node then on the Home tab, click Properties and tick or untick the Aggregate box on the General tab. If aggregation is turned on (ticked), then all the child-specific coding (e.g., Rationalism) will also be included in the parent-Node coding (e.g., Schools of Thought) during analysis.

### Creating Folders

You can create folders to organise your nodes in some meaningful way (e.g., create a folder to store your survey question Nodes) to make them easier to find. Right-click on the Nodes folder to create a new one within it (e.g., Context Nodes). You can further organise nodes by clicking and drag them in and out of folders (e.g., drag Attitude into the Context Nodes folder).
**Merging Nodes**

You can also merge similar Nodes together by selecting and cutting all but one of the Nodes; the remaining one will be the "target Node" you’ll merge them into (e.g. in the Autocoded Social Media folder cut Fisherman and Fishing) then click on the remaining Target Node (e.g., Fishing Industry). On the Home tab, click Merge and then Merge into Selected Node. Select the appropriate option(s) provided (e.g., Merge Child Nodes as well) then click OK.

**[OPTIONAL] Creating a Relationship between Cases**

You can create relationships between Cases and/or other project items in this area of the Node View. For example, Margaret is a member of Carteret Catch. Relationship types need to be created FIRST in the Classifications Area (see previous topic) and applied by right-clicking in the blank space of the Relationships folder (or selecting Relationship on the Create tab) then selecting a Case/Node in the From box (e.g., Barbara), then choosing a Relationship Type from the drop-down menu (e.g., is married to) and selecting another Case/Node (e.g., Ken). Then click OK.

**Using Mind Maps to Create Nodes**

NVivo Mind Maps help you to create a diagram of your coding scheme and its hierarchical structure. As an added bonus, you can also convert the mind map “ideas” into actual Nodes in the Nodes area.

On the Explore tab click Mind Map. Enter a name for the model in the Name box, and an (optional) Description, then click OK. An initial shape is already prepared for you to enter a label for the main idea of the map (e.g., Research Project Title). If you want to add a “child” idea (e.g., a shape connected to the main idea) right-click on the shape and select Child idea and give it a label (e.g., Theme 1). You can add a Sibling idea in the same way (at the same level in the hierarchy of the shape you attach it to). If you want to create an unconnected shape, click the Floating idea button on the Explore tab (e.g., for Available Resources). You can change the colour of a shape by clicking on it and changing the colour from the Fill drop-down menu on the Explore tab. When you’re happy with your Coding structure, select Create as Nodes from the menu at the top of the window, and they will appear in the Node Area.

**Autocoding Nodes & Case Nodes**

You can also create Contextual Nodes (such as a Node for each question to analyse them separately) and Case Nodes using the Autocode function, if you have a spreadsheet file where each row represents one case. Autocode can also be used in Word documents, if you have used Heading Styles to define content relating to one case/theme.
Auto Coding Datasets

You can automatically code datasets, creating nodes for:

- **columns** – e.g., a node for each question in a survey coding the responses in the column to that node).
- **rows** – e.g., a node for each respondent and code the responses in that row to that case node.

**Example:** Auto Code Survey columns as question Nodes.

In the List View of the Sources Area, click on the dataset you want to auto code (e.g., the Survey Dataset). On the Analyze tab click Auto Code and the Wizard will begin to take you through the process. Click **Code at nodes for selected columns** and click **Next**. Select the appropriate column(s) you wish to autocode by moving it into the **Selected Columns** box using the right arrow button (e.g., *The Water Quality Down East is*) then click **Next**. You can auto code multiple questions at a time by moving more columns into this box. Select a location for the Node (e.g., under **New Node** in the location **Nodes**), and give it a name (e.g., *Survey Questions*). Then click **Finish**. This will create a new parent node called *Survey Questions* with one child node called *Water Quality Down East is*.

Auto Coding Using Paragraph Styles

You can use NVivo to auto code your Word documents based on Paragraph Styles: a node will be created for each paragraph formatted in the style selected, and the text under the style is auto coded under the node. For example, you may have Open-Ended Survey questions and responses saved as individual Word Documents for each respondent. If you have applied the same paragraph style to the headings of the questions (e.g., Heading 2), you can auto code each question as a node (as long as the wording is identical across documents).

**Example:** Auto Code the Interview Word Documents.

Select the document you wish to auto code in the Source area (e.g., all the documents in the Interviews folder). On the Analyze tab, click on Auto Code and select Paragraph Style and select the appropriate paragraph style(s) from the list (e.g., Heading 2 to create nodes for each question). Click **Next** and then select a location for the nodes (e.g., under **New Node** in **Nodes**) and give the node a Name (e.g., *Questions*), then click **Finish**. You’ll notice in the Results there are 2 Nodes for Q.6. This is because the questions were not identical – you can always merge these two together.

**Note:** You can also Auto Code by paragraph number this way: choose to code by Paragraph instead of Paragraph Style.

Coding Your Data

**What is Coding Context?**

When you begin to code your data it’s important to consider how much information to include in your Nodes: individual words, partial/whole sentences, paragraphs or even the whole document. Ideally you should provide as much context in your coded data to understand why it was coded in that way.

For example:

“I find television very educational. Every time somebody turns on the set, I go into the other room and read a book.” – Groucho Marx

If you select and code ONLY the first sentence of this quote to the Node *TV is NOT Educational*, you might later think that the coding was inappropriate, because when you open the Node to review it only that sentence would appear. Therefore, when coding it is important that you include an appropriate amount of context in order to justify why you coded it the way you did – not only to yourself, but anyone else you might review your analysis.

Digital literacy training
On the other hand, **including irrelevant information** in the context of your Node can be problematic for analysis. Particularly if you want to identify overlapping content between Nodes and quantify your qualitative data. In the example below, each Node contains a substantial amount of irrelevant text, and there is a spurious relationship between them because only the irrelevant coding overlaps.

![Diagram showing relevant and irrelevant text in Nodes]

**What is Coding-On?**

Often one sentence will be a relevant reference for more than one Node. Coding-on refers to coding the same content at a second, third or fourth Node (this is done in the same way as regular manual coding). **This is why you never need to have duplicate Nodes.**

**How to Code a Selection of a Document to a Node**

**Method 1:** Open a document from the **Sources** Area of the **Navigation View** (e.g., the **ANU Home Page**).

Click and drag your mouse to highlight the section of text that you would like to code under one or more Nodes. Right-click on the selection and choose **Code Selection** from the menu. Then choose to code at either **Existing Nodes**, **New Nodes** or **Current Node** (this is the last Node you coded at). Tick the appropriate box(es) and then click **OK**.

**Method 2:** **Drag and Drop Coding.** If you have your Nodes displayed in the **List View** next to the **Detail View** of your source document, you can select the content you want to code then **drag and drop** the selection to the Node itself.

**Method 3:** **Quick Coding Bar** *(see illustration below).* At the bottom of the window, there is a short-cut bar for coding. Select what you want to code, then choose where you want to code it in the **In** drop-down menu: **a. Nodes** or **Relationships**. From the drop-down menu for **b. Code At** select the appropriate Node from the list. If you want to choose more than one, click on the box with the 3 dots next to the drop-down list, and tick all the appropriate Nodes. If you want to create a new Node, type in the name for that Node in the **Code At** box. Then click on the **Icon** for **Code at Current Node** to code it.

![Quick Coding Bar illustration]

There are also icons for **c. Uncode at Selected Node** and to make a Nodes from the selected text (**d. Code in Vivo**) which automatically chooses the highlight text as the Nodes name (up to 256 characters).
How to See What Has Been Coded within a Source

Double-click on the source to open it, then go to the View menu tab, and click on Highlight and select the appropriate option:

- **All Nodes** (less useful) will highlight everything that is coded to a Node in yellow (including Case Nodes). It doesn’t tell you how it’s been coded.
- **Selected Items** (more useful) will highlight the coding for the Nodes you choose from the menu. (available ones will be in bold type). To reset these choices, select Modify Selected Items.

To see how it’s actually been coded at multiple Nodes turn on Coding Stripes on the same tab. Click on Coding Stripes and select the appropriate option (e.g., Selected Items). Colour-coded stripes will appear in another window on the right-hand side of the screen. These tell you how the sections have been coded and the coding density at each part of the document. You can click on one of these stripes to highlight the coded text for that Nodes (e.g., Real Estate Development). You can right-click on a strip to hide it and to automatically uncode all the text in that document at the Nodes (right-click and Uncode at Node). To unhide a strip, select Modify Selected Items from the Coding Strip drop-down menu and re-tick the appropriate Nodes.

**[OPTIONAL] Coding Audio and Video data**

Example: Code the audio data for the Interview Helen.

You can code audio and video data in two ways: by selecting the text in the written transcript or by selecting sections of the media via the timeline. Coding the transcript is identical to coding normal text data. Open the audio file for Helen in the Interviews folder. If you want to code using the timeline, click and drag to select the portion of timespan you want to code. On the Analyze tab under Code Selection At, click New Node (or Existing Nodes). Choose where you want to store the Nodes in the Location box, enter a Name and (optional) Description and click OK.

If you have a transcript as well, the portion of the transcript which is coded in the timeline is indirectly coded also (but the transcript will not be shown in the Nodes when you open it). When you open the Nodes, you will see a link to the section of audio and its related transcript on the Audio tab.

**[OPTIONAL] Coding Pictures**

Example: Coding a boat in the picture file Competing Water Uses.

You can code pictures in three different ways: by selecting a region of the picture (e.g., the photo Competing Water Uses in the Area and Township internal folder), coding text in the Content column of the picture log (if you have one) or by coding the entire picture source in one. Again, coding the log is identical to coding normal text data. If you want to code the whole picture to a Nodes, code the source as described previously. If you want to code only a section of a picture (e.g., one boat in a photo), click and drag to select the section you want to code. On the Analyze tab under Code Selection At, click New Node (or Existing Nodes). Choose where you want to store the Nodes in the Location box, enter a Name and (optional) Description and click OK.

PDF documents can also be coded as though they were pictures (e.g., areas of the document rather than words in the document). Right-click in the Detail View and select Section Mode then Region instead of Text.

**Uncoding Within Nodes and Sources**

If you make a mistake when coding, or if there are references found in Nodes or the results of queries that do not really fit in with the theme behind the Nodes, you can always uncode that section of text/picture/video/audio. Highlight the reference section to be uncoded, right-click
on the selection and chose **Uncode Selection** and then **Uncode at this Node** (can also uncode it in other Nodes it may be coded at).

The same can be done using the short-cut for coding, by just clicking on the **Icon** for **Uncode at Current Node** (when the right Nodes is in the **Code At** box).

You can also **uncode ALL the references in one source at a Nodes** using the **Coding Stripes**, by right-clicking on the coding stripe for the appropriate Nodes, and uncoding at the Nodes.

**HANDY HINT:** This is easiest to do when you are reviewing the coding you have done within a Node.

**Extra Information on Working with Audio & Video:** You do not need to transcribe in order to code Audio and Video files. However, remember that NVivo cannot search audio and video content when conducting Word and Text Search queries.

---

**Collections Area**

This Area stores links to project items in folders to make them easier to organise and find. It is particularly useful if you are collaborating with other researchers on the same project.

- **Sets** – manually organised group of sources or Nodes (e.g., a folder for “audio files still to transcribe”). (More about this next session).
- **Search Folders** - automatically organised groups of items that meet a search criteria.
- **Memo Links** - any memos you have made in your project are linked here.
- **See Also Links** - any hyperlinks you have made between project items.
- **Annotations** - any annotations you have made in your project are linked here.

---

**Creating Annotations**

**Example: Annotate the Interview for Barbara.**

Select the content you wish to annotate (e.g., *Barbara*) and on the **Analyze** tab click **New Annotation**. Enter the annotation text at the bottom of the **Detail View**. Annotated content will be highlighted in blue and the text will be displayed in the **Annotations** tab at the bottom of the window. This text can also be included in any text searches and/or queries.

---

**Creating Memos**

You can use memos to record any ideas or insights as you progress in your analysis. These can be linked to specific **Sources** or **Nodes**, or **Unlinked**. Memos can include text, tables and annotations. In addition, you can code the content of memos. You can also import existing memos into the Memos folder. Sources that have linked memos display a memo link icon:

**Example: Create an Unlinked Memo for Things to Do.**

To create an unlinked memo, in the **Sources** Area, click the **Memos** folder. On the **Create** tab, click **Memo**, enter a name (e.g., *Things to Do*) and (optional) description, and then click **OK**. It will open in the **Edit Mode** so you can enter content. If you want to **link a memo** to
source/Nodes, click the source/Nodes then on the Analyze tab click Memo Link and then Link to New Memo. Enter a name and (optional) description, then click OK.

Creating Links

Example: Link text in the Barbara Interview to the Charles Interview.

Select the content you want to link from (e.g., a selection of text from the Barbara Interview), and on the Analyze tab, click See Also Link and then New See Also Link. Click the Select button, locate and on the left select the folder that contains the source you want to link from. Then on the right, select the source you want to link it to (e.g., Charles in the Interview folder), and click OK. Linked content will be highlighted in pink and the linked item will be displayed in the See Also Links tab at the bottom of the window.

Note: If you want to view/hide annotations and links from the Detail View, click on the View tab and tick/untick the appropriate boxes in the Links Area.

Creating a New Set

You can use the Sets folder in the Collections area to create virtual folders with shortcut links to project files. Items in a set folder are simply shortcuts to the original files. You can delete an item from a set without removing it from your project. You can create an empty set to add items to later, or create a set based on existing project items.

In the Collections area, click on the Sets folder and on the Create tab click Set. Enter a name in the Name box (e.g., Check Coding) and (optional) Description. Click OK. When you click on the new set folder in the Navigation View right-click in the blank space in the List View. Select Add Set Members from the menu, and select the sources or nodes you want to add. Then click OK.

To remove items from a set, select the items you want to remove and on the Home tab click Delete.

Brief Overview of Other Areas in NVivo

Queries Area

This contains saved queries (searches/analyses) that were run to explore the project data (if you select Add to Project when running the query). (More about this later).

Reports Area

This stores reports of summary information that were run to explore the project. (More about this next session).

Models Area

This contains mind-map type visualisations of your initial ideas. (More about this next session).

Folders Area

Contains all project folders.
Creating Transcripts

You can create transcripts in 3 ways: Transcribe Mode, Normal Mode and by dividing the media into sections. For further information on importing audio and video transcripts, see http://help-nv11.qsrinternational.com/

Transcribe Mode

Example: Transcribing the audio file for Helen.

By using the Transcribe Mode, you can play, pause, forward or rewind as you transcribe, and each time press stop, NVivo creates a new transcript row and timestamp. Open the media source and click on Edit Mode. On the Media tab under Play Mode, click Transcribe. On the Media tab click Play Speed, and select your preferred speed. In the Playback group, click Play/Pause. A new transcript entry will be added. Enter the text for the section (you can pause, rewind and skip back while transcribing at any time). Click Stop when you have completed an entry, then the end time is added to the Timespan field. Continue playing and stopping until you have finished transcribing. Then turn off Transcribe Mode on the Media tab and under Play Mode click Normal.

Normal Mode

You can add transcript entries directly in Normal Mode, by adding a transcript row for a selected timespan and entering the content. Click on Edit Mode, then click and drag on the timeline to select the timespan. On the Layout tab, in the Rows & Columns group, click Insert and click Insert Row. You can also add a new entry without a timestamp this way (e.g., to make general comments) simply by typing in the next entry box.

Dividing Media

You can divide the media into sections by adding multiple transcript entries of equal duration. E.g., divide a 30min video into 5min sections then comment on dialogue/events in each. On the Layout tab under Rows & Columns, click Insert and then click Insert Rows. In the Add Transcript Rows of Duration field enter the duration of each entry (e.g., 5:00 to create entries of 2mins duration). In the From Start Time field, enter the start time for the entries (e.g., 00:00:00 to start adding entries from the beginning of the media). In the To End Time field, enter the end time for the final entry (e.g., 00:15:00 to end the final entry at 15mins). Click OK.

Custom Fields in Transcripts

If you want to add columns in the transcript for information, such as the speaker’s name, click the File tab, point to Info and click Project Properties. Click the Audio/Video tab and under Custom Transcript Fields click the Audio or Video tab. Click the New button and enter a name for the new field. The field will be add to all transcripts in the project. You can use this field when auto coding also.